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Step 1: Windows 8 Installation UDATAP

1. Make sure the printer is OFF and plug a USB cable 2. Turn the printer ON via the power button on the rear-
into the back of the computer & printer as well as right side of the printer. | is ON, O is OFF.
the power cable into the printer and power outlet.

3. The Device Manager will detect your printer. You may 4. Place the installation disc into your CD-ROM/DVD
notice the above icon on the bottom of your task bar. drive. The following tab should appear in the top-right
of your screen, click it.

a Do - o IEN
DVD RW Drive (D) Datama...

Install or run program from youw media

Run D0 pae

Pulsiriher not specified -
Oher choices @
Dy Fobder 10w filed

g datamax-oneil

right by our customer

5. Select Run DO.exe. 6. The installation application will guide you through the
setup. Click the right-facing arrow to continue.



Step 1: Windows 8 Installation UDATAP

a o0 - cEN a o oy . |

3 METira Labal Dasignar

-Class
S-Class
a
7. Click the E-Class Mark lll option. 8. Click Install Driver.

Windows Printer Drivers Windows Printer Drivers

License Agreement rl .S‘F,m,l-,l; Installation Directory rl .S‘F,m,l-,l;
Fesar iead the lolwng Kese kpreaman; Canetaly Fesar e e Soeciiny L woa e s ee

The softwire will be unpachd to lhe dreciory isied beiow. T urpach 1o a it deeciony,

WIHDGWS PRIHTER ﬂRIVER 2 B T i tha new gt o chak [rewee 10 dalect B st dieschiny,
LICENSE AND LIMITED WARRANTY
rtalaben Cenciney BRRCTRT Ko
Samgll Scmrtfe e (eagul | prants yos e renescase enie b e e
SECamEETny VRSss Treier Donan §) 8na relates aoeomentaten Coassul foare mamd on dtve 16 2 ME
oMo ], BubsCE 10 T PG DROvIOnE. V0w BNaume Ml reaposs By Tod 1
Sobce miadable on beleced deve xx0cae

smmction of e Saagsd Snfwans i acheve yoor rilended resis and Tof the
nuislates Une 8o resuts abinmed Frem e Sasgul Safware

LSt 5 g Mwvine Bod 1 retahied mabenal are Copyngiied and are proliched By @w
Tiie o and al rights and flsests o the Seagull SoSwars wheree adest and o
cmisnr mada ars ans uhsl e ma sennas of Caamil Fomssrmans R ssine
¥ | iiapl the laima in the kards sgreandnt

T e net accact the bermm 1 fhe komnes scresmant

Fhnt = Canosl « Back Font = Canosl
9. Select | accept the terms... and click Next. 10. Leave the Installation Directory as is and click Next.
w:ﬂ'lﬂ.ﬂ'ﬂ'!- Printer Drivees 5{"&1”“ Diriver Wizard

Welcome to the Seagull Driver
Wizard

This: wizare bask yous rmtal st rmmmros b dinvere.

Installation Information rl .S‘F,m,l-,l;
Falow T nedrucieone Deicw 1o malal e soSware

A

Mt deyvars are urpaoied mstal them Leng e Do Wiesed
o Wl v yeu low B do?
[+ P Drver Wersed sfier unpacking devens

[ Fsad irsisiation nsracsons comtared in ranlafon_insnctions bl

# Irikall prober chrerrs
nrade pYner drniers
(D Bemarve privter drivens

11. Select Run Driver Wizard... and deselect Read installa-  12. Select Install printer drivers and click Next.
tion... and click Finish.
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Seaquil Driver Wirand

Flog snd Flay Frintes Detection

Mirw g and Py prinkers ane sutomalically detecied for irftallabor

Select the prnber deiver &5 natal
B Ealall o deiver for & Plg acdd May priviles

Prmter Mode! Part

om0/ el E-4005 Mark, 01 JSE000

Ireitall & drvver fior ano/Ter prntar

Bk el > = L1

13. Leave Install a driver for a Plug and Play printer select-
ed; the Printer Model should read Datamax-O’Neil E-

4206P Mark I11. Click Next.

Windows Security

Would you like to install this device software?

. Mame: Datamax-0'Neil Printers
_..—%;é Publisher: Seagull Scientific, Inc

Don't Install

& You should enly install driver software from publishers you trust. How can | decide
which device software is safe to install?

Always trust software from "Seagull Scientific, Inc". Install

15. If the above window pops up, select Always trust soft-
ware from “Seagull Scientific, Inc.” and click Install.

Step 1: Windows 8 Installation

UDATAP

Seaquil Driver Wirand

Specify Prister Rame

Hames are Lacd o idertfy B privier on Be comprder andd on B e Bavork

Ervier b rubimes fior hes prnter
Prvder name . LI 00 Wk ]

of | Lt prnter a8 e cefalt prnter

soedify whater or Aot you it i ghare th rier s offer retwor users. When

sharing, you muss provide & share mame

%) Do ot ghare tha Drrver

Shane name;

Bk et > = L1

14. Leave the Printer name as is and click Next.

Seaquil Driver Wizard [ x|
Seagull Drver Wizard Completed
Successfully

Thoe frsirorg) cpme atorm were compmted axs ety

Ervilalied primber Thabamax -OMel E-4206P Hark [T,

Ireial Anather Prrier Ccne

16. You will see the drivers copy over; this should only take
a moment. Click Close to exit the installer. Your setup
is now complete!
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1. Make sure the printer is OFF and plug a USB cable
into the back of the computer & printer as well as
the power cable into the printer and power outlet.

"=/
&
5 robe e
=Hlw
u.um:c;

3. Ifthe app doesn’t auto-start, navigate to My Computer
and double-click on the drive containing the installa-
tion disc, usually (D:); otherwise ignore this step.

@ [E———y

Accessories CD

5. Select the E-Class Mark Ill from the list and then select
Professional and Professional Plus model.

Step 2: Windows XP/Vista/7 Install

UDATAP

-
H AutcPlay ==

m DVD Drive (D:) DO ACC

["] Always do this for software and games:

Install or run program from your media

Run DO.exe
Publisher not specified

General options

COpen folder to view files
b using Windows Explorer

View more AutoPlay options in Control Panel

2. Place the installation disc into your CD-ROM/DVD
drive. The disc should auto-start with a screen as seen
above. Select Run DO.exe.

datamax-oneil

right by our cuttomern.

4. The installation application will guide you through the
setup. Click the right-facing arrow to continue.

S oEN
Accessaries (D

d':; dataman oneil

E-Class Mark Ill

6. Click Install Driver.
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WINDOWS PRINTER DRIVER
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9. Select Run Driver Wizard... and deselect Read installa-

tion... and click Finish.

Seagel e W

Lpecify Printer Fodel
The manufachser and madel detoimne which prirder deiwer o use.

Spacify the model of your prnter,

| Prwiter Model

| Db £V F-A 358 Mark 11T

| Combaman-CPhed E-4705 Mark 11

| Db -CrH E-47060, Mark 17

o ot o o
| Covbaman el E-43048 ok (11

| Drrtarman el E-4 3004 Mk 11

| Doty O/ E-43058 vl 111 _
Sareer Ci'Seagull F—— '|
Werson:  T.L1I(D3/1N2011)

wBack | Mestr | | comn |

11. Select Datamax-O’Neil E-4206P Mark 11l and click Next.

Step 2: Windows XP/Vista/7 Install UDATAP

Installation Directory qm

Fass prwtt Fa Secizsy i eepech By scflwirs

Thee scftware wil B urpached 15 B esciony lated boi . To-urpach 18 & St Smsiory
bt o i e e e o ol e o et 3 et Sty

Wielcome to the Seagull Driver
Wizand

Tt s . o il e Fc g e s

et w80 ot
& Trutel grvie e

Ubgrade e dvern

Ao irrir S

|
L

10. Select Install printer drivers and click Next.

& port m e I corrrT i R I P Coeater

Specfy Fur port Bl you e usg. B frod e darrecteg ueng TOMIP of e port toe
oo el ingienl, (RAAAR O PEW DO |

Pt T

i Fwahr P

=, LIE S Pl (RO D] I
o Locw Part

ful: Lo P

SR 18 Wy et -

12. Select USB001 under Port and click Next. (USBOO1 will
almost always be the correct option; sometimes it can
be USB002, USB003, etc.)
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ey Penber Sane
M o ussd Lo oadeitdy e it of e competer and on e st

Erter & e fur Ui ke,

Prinkar pams; | Dt arma =Ciied E-A2048 Mark 111
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[ Shaees name:
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13. Leave the printer name as, deselect Use this printer...
and click Next.

Enatalling Drrvers
Pirorar vl wihir your apatem moguiated

[restinling printer Tiatamanc-Ohed E-4200F Mark [T ..

15. You will now see the drivers install; this should only
take a moment.

17. Turn the printer ON via the power button on the rear-
right side of the printer. | is ON, O is OFF.

Step 2: Windows XP/Vista/7 Install

UDATAP

Completing the Seagull Driver

Wizard

& ey prink e vl be installed ugineg bhe Follonsg sethings
Piames; Dt a0 el L-4206F Mk, 11
Shang rme: ok Shareds
Porl: U5B002
Dl vl L
Marwdacther:  Dabamas-0Hel
Maxchal: Db s <0l -4 T0ER Mk, 111
Wiersion: 7.2.0 (D3N TR011)

T Beigary thed cirivdr installation process, chck Finkh,

chak || Foih | | cCowel

14. Click Finish.

==

Seaqull Driver Wizard Completed
successfully

The follewing eperations were completed sucorssfully:
Insiabed prinber Talamax-0Med E-<4206° Mark IIT.

| st dewthoes Prester

16. Success! Your Datamax Printer drivers are installed.
Click Close to exit.

Installing device driver soltwane
Chck uren Por Eaun

18. Windows Vista/7 Users: You may see the following

pop-up or one similar appear on the bottom right of
your screen.
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Step 2: Windows XP/Vista/7 Install UDATAP

Welcome to the Found New
Hardware Wizard

This vl Pueipen o) ircetnll soltvsans ot

Dratannac0Med E-Class Maddll

J 18 pour hardwase came with an inslsllation CD
‘oz e Floppy dizk imsei @ nis

‘bt c o ek b winand i da?

() hruttall the poftwase subamatic sl [Recommended]

() hresisll e 1 st o e Incation |Acheanced]
Dt -0 bl E-42060 Markm ™
'ﬂ' Pwoc i dsyaw sofoadey intalled 1w ooty

Click: Mlesst ko confinue.

Mewd > Larwonl
19. Windows Vista/7 Users: Wait a brief moment and you

20. Windows XP Users: When the above screen appears,
should receive an installation confirmation. Your setup go ahead and click Cancel.
is now complete.

Welcome to the Found New
Hardware Wizard

This vl Pueipen o) ircetnll soltvsans ot

b0 el E-4 2065 Mak: 11|

J 18 pour hardwase came with an inslsllstion CO
‘oz e Floppy dizk imsei @ nis

‘bt c o ek b winand i da?

() hruttall the poftwase subamatic sl [Recommended]
() skl o 5 it 0 e lnction JAchvancesd]

Click: Mlesst ko confinue.

i onprel e Hardhware
i probisn cocurned dumeg hardess retalation. Vo nes
Mok > Ll

| e et ot ek ey

. o0
21. Windows XP Users: When the above screen appears, 22
go ahead and click Cancel as well.

- TFM

. Windows XP Users: Ignore the following pop-up as
well. Your setup is now complete.



Step 3: Loading the Fanfold Stock UDATAP

1. Lightly scratch the paper with a pen cap, coin or fin- 2. To open the lid, press forward on the gray, arrowed
gernail and look for a black type of smear. This is the notches on the side of the printer.
printable side and should face UP in the printer.

3. Feed the paper through the rear of the printer, into 4. Continue to feed the paper through the front guides,
and under the teal guides. making sure the stock in under the small teal tabs.

5. Pullthe stock forward soit’s just hanging overtheedge 6. Confirm the small white arrow on the top and bottom
of the black roller, right on the edge of the gray lip. feed sensors are both pointing to 0.



Step 3: Loading the Fanfold Stock

UDATAP

7. Gently close the lid and listen for the lid to latch. The 8. We recommend keeping the fanfold stock about 8-12”
Label Feed button will blink green if the stock is prop- away from the back of the printer for optimal feeding.
erly aligned within the printer.

10
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Step 4: Office 2007/10 Setup

Nammerdl &4

1. Open Word and navigate to the Mailings tab. Once
there, select the Labels button.

Label Options

e

Printer information
(%) Continuaous-feed printers
O Page printers

Label infarmation

Label vendors: | Seiko Instruments USA Inc. [v]

Find updates on Office.com
Product number:

Label infarmation

iSIT SLP-1BLE Blue Address, small

SII 3LP-1GLE Green Address, small
SII SLP-10LE Crange Address, small
SIT SLP-1PLE Pink Address, small

SII SLP-1RL Address, small

SII SLP-1RLE Address, small

[A] Type: Address Label
e Height: 3.28"
Width: 0.94"

Page sizet 0.94" = 3.28"

’ Details... ] IﬂewLabeI... I

[ ok

l’ Cancel ]

3. From this pop-up, ensure Continuous-feed printers is
selected and click on New Label...

| Cabet Dunaiis &
| Frevvsess
Sale mingre
|
Rttt [ k
: gy oMb dove
.
Pimber sroes
| Ikl reisre: Datamax 4x3
| Lo v L S0 Latwl haghe 1 =
| e g o B Ll gkt . -
| et gt o Husdwe gooss -
Hhrdies 1 *
Puage sum: 4% il

5. Change both the Vertical pitch and Label height to 3.
Change the Label width to 4. And finally, change the

Number across and the Number down to 1.

UDATAP

' Ewwelopes and Labah

o

B

Lnkesis

ahal
Ot fCimtnre, 42
Cousbom teo, sl

) Pull pages of the e Labal
1 S Lol

Belre privding, irsonl babeoki i your prasler's sail heoder,

[t Pieevs uaeni

Lo | | Eposagn Peopertimn s |

|

2. Once this window pops up, click on Options...

| Cabet Dunaiis &
| Eraves
Scda mrgra
N
Kt [ 3
r " 5 Neambeer dowry
.
Pimber scross
| Ikl reisre: Datamax 4x3
| Lo e o & Labwi gl 1 =
| g mamngn: o & Lkl guih . =
| el pilahi; S sk g s
Harden v 1 =
T T |

[ o]

4. Change the Label name to whatever you’d like. We
used Datamax 4x3. Change both the Top margin and

Side margin to 0”

| Cabet Dunaiis &
==
Sale mingre
it
Rtk [ k
: 'T | Namber down
Piumber Soss ;
| Ikl reisre: Datamax 4x3 .
| Lo o e ua ¥ Latwibhpgle 1 ¥
| e mamngn: o ¥ Lokl puitht 4 ¥
| ‘gt ol ks n bder oo s
T | =
B stimi 4% ol

[ o]

6. Double-check your inputs and click OK.

11



Step 4: Office 2007/10 Setup UDATAP

| Envebopas and Labah lﬁ
Label Options i.'“q-'; = |
Frinter information e W = [ useeirn ke
(%) Continuous-feed printers | ied |
() Page prinkers

Label infarmation

Label vendors:  [iOEher/Custom i-v-

Find updates on Office. com

bl
Product number:

) Pull pages of the e Labal
Label infarmation

e {1t e, Datamax 4x3
Sl bl Custom (i, mabris
Datamax 4x3 Type: Custom dok: matrizx I
Height: 3"
Width: 4"

Page size: 0.94" = 3.28"

Belre privding, irsonl babeoki i your prasler's sail heoder,

- ] il | ;
[ Details. .. ] ’ﬁewLabel... ] [ Delete ] l oK J ’ Cancel ] o L SR

|

7. Confirm Continuous-feed printers is selected and click 8. From this window, click New Document.
OK.

pc/nametag “‘-‘-‘f

9. A new document will be created with the dimensions

of the name tag; press the space bar once to begin
formatting your name tag.

10. Style your name tag as you see fit. For best results,

center text and logos to ensure information is con-
tained on a single tag.

pc/nametag®

11. Navigate to the File tab and select Print. Confirm your
printer is the Datamax-O’Neil E-4206P Mark Il and

12. Your name tag will now print! Be sure to save your
name tag for future use if needed.
click Print.

12
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W

Toelps e oot rgmet Dok Tie v e
- [t o s

1. Upon opening Word 2003, select File, then Page

Setup...

b 2]

e
Remn  GoR

Frawy 1

Swra sl Feed [Traw £F
2 & Ty & -

Trae 3 il (o3 »

Cosar.. ]

3. Click over to the Paper tab. Here, set your Width to 4”
and your Height to 3”. Leave everything else as is and
click OK.

L
Do [ See  [rest Fgma Joss

Mot el Ward

Tl grw o

i

5. The document will now resize to fit our dimensions;
press the space bar once to begin formatting your
name tag.

Step 5: Office 2003 Setup

UDATAP

v | pacer | Loyt |

P

e & B semi
[T % e %
goam T R e T

[ e
g

. ——
(=T Ce e

2. On the Margins tab, set Top, Left, Gutter, Bottom and
Right to 0. Ensure the Orientation is set to Landscape.
Then click OK.

/ ' One oF more margins are sek outside the printable area of the page. Choose the Fix
button to increase the appropriate margins.

[ Fix

1 L_lgnore ]

4. Word will alert you that your margins are possibly
setup improperly. We’re going to click Ignore, as this
allows us to work to the edge of the name tag.

L
Do [ See  [rest Fgma Joss
nr 3 F z

Mot el Ward

Tl grw [

i

pc/nametag®

6. Style your name tag as you see fit. For best results,
center text and logos to ensure information is con-
tained on a single tag.

13



Step 5: Office 2003 Setup UDATAP

mwmmmmuh

Prrer

Bame: b Detat-CrN 42088 Mark 101 -vj ur'u-‘ln il
il

'Iﬂ::?{ Dt armanc -l E 42008 Mar, 11

Where: L] [] Print o File

Commert; [ Moruin e

P tenge Copee

of. | beamber of gopies 1 s

O pages: (2] Colae
Erder g iumbesis arclfon fuisgs
s abed by Comme, Fﬂnlrﬁ..:l 35=12

Frinit what: | Docuitent :_
:‘ Poges pre sieet! | page

Prind; &l pages inrange E:
Scale 1 pager S | Scing |
7. When ready to print, select File, then Print... 8. Confirm your selected printer is the Datamax-O’Neil

E-4206P Mark 11l and click OK.

9. Your name tag will now print! Be sure to save your
name tag for future use if needed.

14
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Note: This step is purely optional. The point of adjusting
print temperature can allow for a darker or lighter image
in regard to the thermal transfer. The higher the tempera-
ture, the darker the image and vice versa.

To begin:
XP: Click Start, then Printers and Faxes

Vista: Click the Windows logo, Control Panel, then Printer
Seven: Click the Windows logo, then Devices and Printers

Eight: Initiate the Start screen, start typing “control panel,”
click on Control Panel and then View Devices and Printers

See what's printing
Set as default printer
Printing preferences [:}

Printer properties
Create shortcut

Troubleshoot

Remove device

Properties

2. ...and select Printing preferences.

) Al e o ) | .

4. Or to the left for a lower temperature and fainter
image.

Step 6: Adjust Print Temperature

UDATAP

\\_"LP Datamax-0'Meil E-4206P Mark, 111

e ]
Reaady

1. Right-click on the previously-installed Datamax-O’Neil
E-4206P Mark IlI...

) Al e s I | s, |

3. Select the Options tab and check Send with job. Move
the slider to the right for a higher temperature and
darker image...

) Al e s I | s, |

5. Click Apply once your temperature is set and continue
printing as your normally would.
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Step 7: Label Template Reference

Nickname

First Name Last Name Title
Full Title

UDATAP

Badge 01

Nickname

First Name Last Name Title
Full Title

pc/nametag

Nickname

First Name Last Name Title
Full Title

Badge 02

Badge 03

pc/nametag

Nickname

First Name Last Name Title
Full Title

Line 1
Line 2

Line 3
Line 4

Badge 04

Badge 05

Badge 06

16



Step 7: Label Template Reference  UDATAP

‘ pc/nametagr

First

Organization
City, State

Badge 07

pc/nametag’

First

Badge 09

pc/nametag’

Full Name, suf
Title

City, State

Badge 08

‘ PC/ nametag-

Title

Organization
Country

Badge 10

17
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pc/nametag
Nickname

Badge 03

First Name Last Name Title
Full Titke
pc/nametag
Nickname
Badge 04 First Name Last Name Title
Full Title

Note: This step is for adding your own company logo to
the pre-made badges listed earlier: Badge 03 & Badge 04.

2. Delete the existing logo by selecting it and hitting the
Backspace key.

B e

Uil Pt W d

4. Size your logo to 4” wide by 34" tall, maximum. Note:
The graphic will automatically left justify if it’s not a
full 4”; add white space if you need to justify it.

Step 8: Add/Change Template Logos UDATAP

raal (']

Do & Sen pewt Fgma ok Tgke e e

i

pc/nametag-

1. Open the file named graphic.docx that is located on
the item page on our website. You can find this by
going to www.pcnametag.com and typing UDATAP in
the search bar. Click on the “Product Manual” tab,
and download. Open the UDATAP folder, then the
Templates folder. The graphic.docx file is located in
this list.

M

B fl Ve | et | e [l Tge rdos b

» % .

3. Insert a new logo by selecting Insert, Picture, then
From File... Browse to your logo, select it and hit Insert.

We now need to modify the printer driver to allow for this
new logo to be stored to the printer. Leave the Word doc-
ument open for the time being.

5. To begin:
XP: Click Start, then Printers and Faxes

Vista: Click the Windows logo, Control Panel, then
Printer

Seven: Click the Windows logo, then Devices and
Printers

Eight: Initiate the Start screen, start typing “control
panel,” click on Control Panel and then View Devices
and Printers

18
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@

6. Right-click on the previously-installed Datamax-O’Neil

E-4206P

8. Select the Tools tab and click on Manage Cache...

Datamax-C'Meil E-4206P Mark, TIT

0
Feady

Mark I11...

& Datamax-O'Neil E-4206P Mark Iil (Copy 2) Properties [2 %)

Genoial | Sharing | Pots | Advarced | Secusty  Forts | Tools  About
Printes
Prtv  Acton~v  [orbgue »
Dirvan
[ Diives Optices ] [ Loogrg Opbon: J
Status Mondotng e Cache.
ok | [ Cancel [ Heo

See what's printing
Set as default printer
Printing preferences [}

Printer properties
Create shortcut

Troubleshoot

Remove device

Properties

10. Right-click on the Datamax-O’Neil E-4206P Mark I/
icon again and select Printing preferences.

Step 8: Add/Change Template Logos UDATAP

Open

Printing Preferences. ..

Pause Printing

sharing. ..
se Printer Online

Create Sharkouk
Delete
Fename

Properties

7. ...and select Properties.

Manage Cache Elgl

Cache Selfings | Cache Conterts

Storage Memoty
Caching memaody is the total amount of memoey 1eserved for cached
formats and cached graphics

Cache Memory: 1226 3 &

Cache Storage Module C v
Tempotasy Storsge v
Advarced

Frrst Graphic 1D 0 =5 Frst Format 1D
Last Graphic D 9 =

“© 0

Last Foemat ID ]

ot J[ Cocd J[ oo J[ Heo ]

9. Next to Temporary Storage, change the drop-down
from Module C to Module G. Click Apply, then OK.

& Datamax-O'Neil E-4206P Mark 1l (Copy 2) Printing... [2 |fX]

Page Selup | Graphecs | Stock | Ogons | About

R ISE R 14.00 1 x 6 00 in]

[ New ][ Ex ]
Preview Orertation Elfects
® Potrat [ Moot Image
ALE O Landscape [INegalive
- O Pytrat 160°
O Landgcape 180"
Presot
Mg <Cutrent Settingr> v
l Adyanoed Opbions

© 13992012 Seagdl Sciertlic, Inc
Authors of the BaTender® label sollwie

o] [ Conent [ o]

11. Select the Page Setup tab and click on Advanced
Options...

19



pc/nametag

Advanced Options

Step 8: Add/Change Template Logos

{ Prting Poston]| User Conmands | Dives Options | Passtheough

User Commands

Start of Job “¢STXOL
Start of Label
(End of Labal |

End of Job

Function Character: | v

The lunction character is used Lo inseit contiol chalacters in both user
commands and bat code fonts

|nsent »

ok [ Cencel |

12. Select the User Commands tab, then select End of

Label. Type A<STX>L in the field to the right.

Advanced Options

| Piinling Pasition | User Commands | Driver Options | Passthiough|

User Commands

Stait of Job E
Statt of Label
End of Label

Function Chacactes: | * v

The function character is used to nzert contiol characters in both user
commands and bar code fonts.

Insest »

(o J|

Cancel | Apoly

right. Click Apply then OK.

T =
NN L

il b b > ) BionEa oe e gl omiflipueea:ne

pu et nEl

14. Switch back to Word and print a single badge.

Badge 03

Nickname

UDATAP

13. Now select End of Job and type E into the field on the

First Name Last Name Title
Full Titke ‘
Nickname
Badge 04 First Name Last Name Title
Ful Title i
72
ol

15. Upon printing, the new logo will be stored to the

Datamax printer. When printing Badge 03 and Badge

04 from now, your new logo will print.
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